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IINNTTRROODDUUCCTTIIOONN  

 

A Brief History of Automotive Emissions Controls 

In 1960, the California Motor Vehicle Pollution Control Board is established. Its primary function 
is to test and certify devices for installation on cars for sale in California. Also in 1960, the US 
Federal Motor Vehicle Act of 1960 is enacted which requires federal research to address 
pollution from motor vehicles. 

In 1961, the first automotive emissions control technology in the USA, PCV (Positive Crankcase 
Ventilation), is mandated by the California Motor Vehicle State Bureau of Air Sanitation to control 
hydrocarbon crankcase emissions. PCV withdraws blow-by gases from the crankcase and re-burns them 
with the fresh air and fuel mixture in the cylinders. In 1966, auto tailpipe emission standards for 
hydrocarbons and carbon monoxide are adopted by the California Motor Vehicle Pollution Control Board. 
They are the first of their kind in the USA. In addition, the California Highway Patrol begins random 
roadside inspections of vehicle smog control devices. 

In 1967, the California Air Resources Board is created from the merging of the California Motor 
Vehicle Pollution Control Board and the Bureau of Air Sanitation and its Laboratory. Enacting 
legislation is the Mulford-Carrell Air Resources Act, signed into law by governor Ronald Reagan. 
Additionally, the US Federal Air Quality Act of 1967 is enacted, which allows the State of 
California a waiver to set and enforce its own emissions standards for new vehicles based on 
California's unique need for more stringent controls. 

In 1988, the California Clean Air Act is signed by Governor Deukmejian, which sets forth the 
framework for how air quality will be managed in California for the next 20 years. Also in 1988, 
the CARB adopts regulations (OBD II) effective on 1994 model cars requiring that they be 
equipped with on-board computer systems to monitor emission performance and alert owners 
when there is a problem. 

In 1990, the US Clean Air Act Amendments of 1990 are signed into law by President George 
Bush. They rely largely on elements of the California Clean Air Act, and require a number of new 
programs aimed at curbing urban ozone, rural acid rain, stratospheric ozone, toxic air pollutant 
emissions and vehicle emissions, and establishes a new, uniform national permit system. 

Source: www.arb.ca.gov. 

http://www.arb.ca.gov/
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What is EFILive? 

EFILive is a PC based, OBD II Scan Tool and Tuning Tool that has been designed by EFI (Electronic 
Fuel Injection) tuning experts to be used by anyone who needs to diagnose, monitor and tune high 
performance engines.  

The EFILive Scan Tool provides real time logging of critical engine performance data, including, but not 
limited to, RPM, throttle position, spark advance, knock retard, long and short term fuel trims, fuel 
injector pulse widths and duty cycles, commanded air/fuel ratio and oxygen sensor voltages. 

The EFILive Tuning Tool  can edit calibration 
data and save the changes to your PCM 
permanently. Over 180 generic and 
enhanced parameters provide complete 
coverage of the vehicleôs performance data. 
And over 350 PCM (Powertrain Control 
Module) calibrations can be edited. 

Using bidirectional controls, the Scan Tool 
will perform diagnostic checks usually found 
only in expensive OEM (Original Equipment 
Manufacturer) scan tools. The Scan Tool 
can perform the cylinder balance test and 
the crank position sensor relearn. 
Additionally, it can control auxiliary systems 
such as the electric fans, air conditioner, idle 
control, evap canister purge and vent 
solenoids, along with many others. 

For dynamometer use, the Scan Tool can lock the torque converter clutch and hold the automatic 
transmission in any gear. This prevents unwanted and dangerous transmission kick downs when 
performing wide-open throttle dynamometer runs. 

The Scan Tool is also a full featured generic scan tool that will log real time generic data, display and 
clear emissions related trouble codes and display the test results of onboard monitoring systems such as 
O2 monitoring and the system readiness tests. As a generic scan tool, EFILive is compatible with almost 
all GM OBD II vehicles. 
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Fundamentals of GM OBD II EFI Engines: 

Below is a list of the important components for OBD II engine operation: 

¶ Vehicle Speed Sensor (VSS) 

¶ RPM Sensor 

¶ Intake Air Temperature Sensor (IAT) 

¶ Engine Coolant Temperature Sensor (ECT) 

¶ Throttle Position Angle Sensor (TPS) 

¶ Exhaust Gas Oxygen Sensor (HO2S) 

¶ Manifold Air Flow Sensor (MAF) 

¶ Manifold Absolute Pressure Sensor (MAP) 

¶ Barometric Pressure Sensor (BARO) 

¶ Knock Sensor (optional) (KS) 

¶ Powertrain Control Module (PCM) 

¶ Air Injection Reactor (AIR) 

Cold starts 

In the "good old daysò, you pulled the choke, pumped the pedal a few times and turned the key. 
Hopefully, the engine cranked, vacuum pulled some fuel from the carburettor, the points opened to send 
a spark through the distributor and the engine sputtered to life. Starting an OBD II car with a cold engine 
begins a completely different process! 

Today's cars have computers that process calibrated data points, called "tables", to control the operation 
of the engine. Different sensors provide real-time data, used by the PCM to decide which table to use 
and when. 

The reason for this computer-controlled system is first to decrease exhaust emissions, second to 
increase fuel economy and finally to increase performance and make servicing the engine simpler, in 
that order. Turning the key ñwakes upò the PCM and cranks the starter. After ignition and idle 
stabilization, the engine management system is in a state called open loop. It is called open loop 
because the primary sensors in this system, the oxygen sensors, are not hot enough and will not be 
used by the PCM until they are. In addition, but unrelated to open loop, the catalytic converters (cats) 
need to be very hot to perform their exhaust cleaning function. Open loop uses pre-programmed 
information, based on the specific engine application and provides adequate performance, economy and 
emissions while the engine warms up. The mixture is usually much richer (like the choke in the "old 
days"), both to keep the engine running better and to get the cats hot. 

Most OBD II cars use heated oxygen sensors that have filaments (like a light bulb) to get them hot as 
fast as possible, and an AIR pump to blow extra air in the manifold to burn the extra gasoline to heat the 
cats quickly. Therefore, open loop rarely exceeds a few minutes of operation. In open loop, the PCM 
also uses the MAF, ECT and IAT sensors to determine how much fuel enrichment is needed to keep the 
engine running prior to reaching operating temperature. 

Once the PCM determines that the oxygen sensors are within their operating temperature and other 
conditions have stabilized, it changes mode from open loop (ignoring the oxygen sensors) to closed loop 
(using the oxygen sensors). 

To keep a warm gasoline engine running, requires about 15 parts air to 1 part gasoline. The optimum 
ratio is 14.7 to 1, but this may vary under different operating conditions and the desired performance 
demands of the engine. Restricting fuel creates a LEAN mixture and adding fuel creates a RICH mixture. 
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Fuel injectors 

OBD II engines are fuel injected individually at each cylinder. In order to vary the amount of fuel for 
different RPMs, the duration of the operation of the fuel injectors needs to be precisely controlled. Since 
the fuel pressure is constant (from the pressure created by the fuel pump) and the nozzle in the injector 
is fixed, the only way the PCM can control the amount of fuel is to turn the injector on and off. (Of course 
as the MAP changes, so will the pressure in the cylinder; this information is compensated for.) Fuel 
injectors can be measured by their "duty cycle", which indicates the percentage of time that they are 
injecting fuel. A duty cycle of 50% means that the injector is supplying fuel at 50% of its capacity. To 
keep good control and to prolong the life of the injectors, 80% is the recommended maximum 
sustainable duty cycle. The actual operation of the injector happens EXTREMELY fast, in the order of a 
few milliseconds (thousandths of a second). The duration of this fuel flow is called the injector pulse 
width. 

Short Term Fuel Trim 

With the information from the sensors, the PCM knows the conditions in the engine, how much air is 
flowing and therefore, the desired load to be placed on the engine. But how does the PCM know the 
amount of fuel to inject? This is the main function of the oxygen sensors. The oxygen sensors generate a 
small electric current, with voltage varying from around 0.1 to 0.95 volts. Less voltage indicates a lean 
condition and more voltage indicates a rich condition. They measure the difference between the amount 
of oxygen in the exhaust and the amount of oxygen in the atmosphere. 

Since the PCM knows the amount of air and fuel entering the engine and, from the oxygen sensors, the 
amount of oxygen remaining after combustion, it can determine if the combustion process was rich or 
lean. This is a direct feedback system and enables the PCM to "Close the Loop"! 

Because the feedback from the oxygen sensors can only be applied ñafter the factò, it causes the PCM to 
ñchase its tailò to achieve the correct combustion. This chase can be observed clearly in the oxygen 
sensorsô output, which under everyday driving conditions looks like a wave. 

 

The combustion process is constantly oscillating between rich and lean. As long as this process 
continues to change from rich to lean in a timely manner, the PCM ñknowsò that the combustion is within 
acceptable limits. If the oxygen sensor voltage stays high or low for too long, then the PCM adjusts the 
amount of fuel delivered by the injectors. This adjustment is called the Short Term Fuel Trim (STFT) 
correction. 

Long Term Fuel Trim 

The main function of the PCM is to store and maintain calibration tables. Most tables are static, they are 
set in the factory and do not change. The Long Term Fuel Trim (LTFT) correction table is different; it is 
modified by the PCM in response to the changing STFT correction. 

For example, if the oxygen sensor voltage stayed low due to a lean combustion process, then the PCM 
would increase the STFT correction. If the correction does not bring the combustion process into 
acceptable limits then the PCM will increase the STFT correction even further. If that process continues 
and the STFT reaches its pre-determined upper limit, then the PCM records that; the particular 
conditions under which the engine is currently operating, require a longer-term correction to be applied. 
The PCM will then increase the LTFT correction and reset the STFT correction back to zero, and the 
whole process begins again. 
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What happens if the LTFT correction reaches its upper or lower limit? The PCM will set a Diagnostic 
Trouble Code (DTC) to alert the driver that the engine is operating outside of acceptable limits and the 
PCM can no longer compensate. 

The LTFT corrections are stored in a table made up of 23 cells. There are 16 cells for most driving 
conditions, with 7 additional cells for things like WOT (full throttle) and other conditions. Each cell 
contains a LTFT correction for a specific engine operating condition. The LTFT correction is used by the 
PCM to increase or decrease the injector base pulse width in an attempt to keep the combustion process 
at the desired level. 

You may have heard that the PCM ñlearnsò, or ñtunesò itself for changing conditions. The LTFT correction 
is the information that the PCM learns and stores. It can also be reset (by disconnecting the vehicleôs 
battery or by using a scan tool), causing the PCM to have to relearn the LTFT corrections. The PCM 
relearns each cellôs value as and when the engine operating conditions require the PCM to use those 
cells. 

Here is how it operates; the following table is an example of a LTFT correction table. 
 

MAP vôs RPM 0-899 900-1399 1400-2199 2200+ 

0-36 kPa (0) 1.5% (1) 1.6% (2) -0.5% (3) -3.0% 

37-56 kPa (4) 2.0% (5) 1.5% (6) 3.7% (7) -1.2% 

57-76 kPa (8) 3.0% (9) 3.6% (10) -2.8% (11) -1.0% 

77+ kPa (12) 2.1% (13) 1.0% (14) -3.8% (15) -2.0% 

The 16 squares represent the LTFT cells, 0 through 15. The PCM knows the RPM and the MAP, 
therefore it can lookup the required cell for the current MAP/RPM engine condition. For example, for an 
engine speed of 1500 RPM and a manifold pressure (MAP) of 50 kPa, the corresponding fuel trim cell 
that the PCM would use is cell# (6). The value contained in cell# (6) is the percentage correction that 
should be applied to the PCMôs base fuel schedule. In this example, the injectorsô base pulse width will 
be increased by 3.7%. 

Spark knock 

As with the fuel tables, for the ignition there are spark tables. (Older cars had weights and springs in the 
distributor to advance the spark timing because as the engine turns faster the spark needs to fire 
sooner.) The spark tables are fixed data points that use all of the above sensors to determine the best 
time to fire the spark plug, to get the most power with the least pollution. 

However, one very important ignition factor must be taken into account ï spark knock, and pre-ignition. 
These conditions may be caused by: 

¶ The spark plugs firing too soon, which could be caused by having too much advance calibrated 
into the spark table(s). 

¶ Malfunctioning sensors may cause the PCM to incorrectly calculate too much spark advance. 

¶ Excessive combustion chamber temperatures; a lean fuel mixture will cause high combustion 
temperatures. 

¶ Bad or low grade fuel. 

¶ An ignition source other than the spark plug, like carbon build-up in the combustion chamber, 
which may begin to glow and become a source of premature ignition. 
 

 
Pre-ignition is caused by an ignition source other than the spark plug. The PCM 
cannot directly control pre-ignition by retarding the spark advance. 

In these cases there may begin to be spark knock, which can quickly progress to the point of causing 
serious engine damage if not corrected quickly. There are acoustic sensors (microphones) in OBD II 
engines that constantly listen for the beginnings of spark knock and retard the timing (make the spark 
plug fire a little bit later in the cycle). This process is called knock retard. While this reduces power, it 
protects the engine. The PCM is programmed to return to full advance gradually. 
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Adaptive Spark 

Some PCMs can adapt the spark advance for varying octane fuels. In a way, it is sort of like a short-term 
knock retard (called the high-octane adaptive spark), where if the PCM encounters excessive spark 
knock, it presumes a less-than-optimum grade fuel is being used. 

The LS1/LS6 PCM uses a sliding scale to determine the optimum spark advance for the current spark 
knock conditions. Two adaptive spark tables are programmed into the PCM, a high-octane spark table 
that defines the upper bound of the adaptive spark and the low-octane table that defines the lower bound 
of the adaptive spark. The PCM never uses one or the other table exclusively, rather it calculates a blend 
of the two tables based on the high-octane adaptive spark. The higher itôs value, the closer the spark 
advance is to the high-octane spark table. The lower itôs value, the closer the spark advance is to the low 
octane spark table. The PCM increases the high-octane adaptive spark during knock-free operation and 
decreases its value when spark knock is detected. This has the effect of increasing or decreasing the 
overall spark advance based on the short-term spark knock. The adaptive spark usually recovers to 
100% within a few minutes once the spark knock is eliminated. 

Those familiar with LS1/LS6 tuning may be familiar with the "low octane spark table" and may have 
heard that if the PCM ñdrops downò to the low octane spark table that it can be "reset" by adding fuel or 
restarting the car. That is not the case. What most people observe is this, a tank full of low-octane gas 
can cause significant spark knock, causing the high-octane adaptive spark to move towards the low 
octane spark table. Once the tank is filled with high-octane fuel, the knock is eliminated and the PCM 
rapidly moves the high-octane adaptive spark back to 100%. 

Modifications 

All of this should work correctly for many hundreds of thousands of miles, as long as you don't choke off 
the air, plug an injector, foul an oxygen sensor or have any other set of abnormal conditions. The system 
is also designed to compensate for normal wear and different driving conditions. However, if you add a 
turbo, change the camshaft, remove the cats (for off road use only), use a larger MAF, add nitrous, or 
make other significant modifications, outside the ability of the PCM to compensate, you would have a 
very unhappy car! This is where one must actually reprogram the PCM, changing the calibrations of the 
fuel, spark and other miscellaneous tables. The EFILive Tuning Tool can accomplish this. 

Additional note about ñcheatingò an Emissions Test 

Another interesting aspect of OBD II (actually the reason it exists) is its use in testing the emissions 
(pollution) produced by the automobile. The MIL is an all too familiar sign of problems in the system. If it 
is illuminated the car will fail an OBD II emissions test. Knowing that most scan tools can turn off this 
indicator, people have wondered if this can be used to "cheat" and get through the emission test. One 
reason why you can't do this (or just pull the PCM fuse) is that emissions testing stations not only check 
the MIL, but also the System Readiness Testsô status. Multiple drive cycles may be needed to get all 
supported System Readiness Tests to indicate ñReadyò. By then any MIL illuminating condition will have 
reappeared. Also any modifications that cause the MIL to illuminate, even if technically there is no fault in 
the system, will cause an immediate failure. 
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What is OBD II? 

Adopted by CARB (California Air Resources Board) in 1985 for 1988 and later vehicles, OBD I (On 
Board Diagnostics, Generation 1) was designed to monitor emissions related components and alert 
owners to failures. 

OBD I suffered from a number of problems: 

¶ It may not have detected components that contributed towards increased emissions until the 
component had failed. 

¶ Some emissions related systems were not being monitored. 

¶ Nearly all manufacturers implemented it differently. 

¶ Trouble codes were non-standard. 

¶ Scan tool support was proprietary; workshops had to purchase multiple and usually incompatible 
scan tools. 

In 1988 CARB adopted OBD II (On Board Diagnostics, Generation 2) for some 1994 and 1995 vehicles, 
and for all 1996 and newer vehicles. 

Some of the goals of OBD II are to: 

¶ Reduce emissions due to early and reliable detection of component or system malfunction. 

¶ Monitor all emissions related components and systems. 

¶ Enforce more stringent performance criteria for determining component or system malfunctions. 

¶ Use a MIL (Malfunction Indicator Lamp) to alert the driver to any detected emissions related 
failure. 

¶ Standardize DTCs (Diagnostic Trouble Codes) and freeze frame data, to assist the service 
technician in faultfinding and repair. 

¶ Provide standardized, real-time engine data. 

¶ Detect malfunctions before emissions exceed 1.5x the legislated limits. 

¶ Detect malfunctions within 1 or 2 driving cycles. 

In the United States, vehicle manufacturers are required to provide an 8 year or 80,000 mile warranty on 
the catalytic converter and PCM (Powertrain Control Module), and a 2 year or 24,000 mile warranty on 
other emissions control components. 

Additionally, if your state or local jurisdiction requires an EPA-approved Vehicle Inspection and 
Maintenance program (I/M), you may be eligible for a GM Performance Warranty, presuming the 
following three conditions are met (see your Ownerôs Manual for additional details): 

1. Vehicle has been properly maintained in accordance with OEM maintenance schedule.  
2. Vehicle fails an EPA approved I/M test under the emission warranty period.  
3. Failure results, or will result, in vehicle owner having to bear penalty or sanctions under local, 

state or federal laws.  

This warranty includes a list of parts and includes non-GM parts as long as they are labelled "Certified to 
EPA Standards". 
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OBD II Standards 

The OBD II specification is made up of many standards, most of which are published by the SAE. 

EFILive meets the SAE J1850 VPW, J1978, J1979 and J2012 standards for scan tools. 
EFILive meets the SAE J2190 standard as implemented in GMôs PCMs. 
 

 
For GMôs LS1/LS6 engine management system, EFILive also supports: 

¶ Enhanced (manufacturer specific) parameters.  

¶ Bidirectional controls.  

¶ EFILive specific DMA (Direct Memory Access) parameters.  
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Conventions used in this document 

 
Potential danger 

  
 

 
Important information 

  
 

 
Helpful information 

  
 

 
Menu choices, for example File->Properties 

  
 

A->B A series of actions that should be followed. 
  

 

 
Keyboard shortcuts, for example Alt+Enter 

  
 

[ ] Toolbar icon ï image will be the actual toolbar icon. 

  
 

[Name] Name is the caption on a user interface item such as a button or a tab page. 
  

 
$01é$FF Hexadecimal values are displayed, prefixed with a $ symbol. Hexadecimal 

values belong to the base-16 number system. They are commonly used to 
display values from digital computer systems. 

  
 

<install_folder> This means the folder in which you installed EFILive. If you installed EFILive in 
the default folder on C drive then it will be C:\Program Files\EFILive\V7. 

  
 

<data_folder> This means the folder named My Documents\EFILive\V7. 
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Contacting EFILive Support 

Before reporting any problem that you may experience with EFILive, make sure you are using the latest 
version. To determine which version of EFILive you are using, select the following menu option: 
 

 
Help->About 

The latest version may be downloaded from EFILiveôs web site www.efilive.com/downloads. If you are 
running the latest version and are still having difficulty, then please contact us at support@efilive.com 

Please include the following information: 

¶ An email address where you may be contacted. 

¶ The error report that was displayed by the Scan Tool. If no error report was displayed, please 
manually generate a report ï see below for instructions on manually producing an error report. 

¶ For the most recently connected vehicle: 
o Model year (i.e. 2002). 
o Model (i.e. Corvette). 
o Engine type (i.e. LS1). 

¶ The type of interface cable being used. 

¶ The type of USB to serial converter (if one is required). 

¶ A brief description of the problem. 

¶ The actions required to reproduce the problem. 

¶ Any other information that you believe may be helpful. 
 

 
EFILiveôs Scan and Tuning Tool is officially supported for use on engines and 
transmissions listed on our web site here: 

ü http://www.efilive.com/supvehicle 

However, please send any issues that you may have with non-supported GM engines. 
There is no guarantee that we can resolve those issues, but we may be able to offer 
some assistance. 

How to manually produce an error report. 
 

 
File->Generate error report 

  

 
Ctrl+G 

1. Click on the [Copy] button. (Or click on the [Save] button to save the error report in a text file so 
that you can copy the file to another computer that has email access.) 

2. Paste the error report into an email (Ctrl-V) and send to support@efilive.com along with the other 
information. 

The EFILive Usersô Forum 

EFILive provides a moderated forum where you can post questions or comments for other EFILive 
users. The EFILive user community has many qualified and experienced scan tool users. 
You can browse the forum here: http://forum.efilive.com/ without registering. 
If you want to post a question or comment then you must register. Registration is free.

http://www.efilive.com/downloads
mailto:support@efilive.com
mailto:support@efilive.com
http://forum.efilive.com/
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RREEQQUUIIRREEMMEENNTTSS  

PC/Laptop 

Configuration Recommended Minimum
1 

CPU type Pentium class CPU (Includes 
AMD and Cyrix) 

Pentium class CPU (Includes 
AMD and Cyrix) 

CPU speed 800MHz or faster 500MHz 

Free
2
 memory 64Mb or more 32Mb 

Free
3
 hard disk space 100Mb or more 100Mb 

I/O port
4
 2 x USB 1.1 or 2.0 USB 1.1 

Pointing device Mouse, trackball, touch pad, etc. 

Keyboard Standard PC keyboard 

Screen Standard PC Screen 

Operating System Win2K, WinXP Win98, WinMe 

 
1
 PC configurations that are below the recommended configuration may not support the full features of 

EFILive. For example, a 230MHz Pentium may not be able to update all the gauges on the default 
dashboard while logging real time data at 10 frames per second. In such cases you can reconfigure 
EFILive, see Appendix-G How to optimize data logging. 

2
 Free memory means memory that is not already in use by Windows. 

3
 Free hard disk space means space that is not already in use by Windows. 

4
 Two USB ports are only required if you are upgrading from FlashScan V1 to FlashScan V2, otherwise 

only one USB port is required. 
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Tutorials 

EFILive Tutorials are available via the Help menu in both the Scan Tool; and Tuning Tool Software 
packages. 

 

 
Help->Tutorials 

Most tutorials are Adobe PDF documents and can be found in the folder: 
\Program Files\EFILive\V7\Docs\Tutorials 
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OBD II cable 

Cable type Support 
AutoTap AT1 V2.x Scan Tool only. 

AutoTap AT123 V2.x Scan Tool only. 

AutoTap ATU Scan Tool only. 

EFILive FlashScan V1 Scan Tool and Tuning Tool. 

EFILive FlashScan V2 Scan Tool and Tuning Tool. 

AutoTap, AT1, AT123, ATU and VIA are products of B&B Electronics Mfg Co. 
www.autotap.com 
www.vehicleinterface.com 
 

http://www.autotap.com/
http://www.vehicleinterface.com/
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Vehicle 

Vehicle/Powertrain Features 
GM LS1/LS2 
and compatible controllers  
 
Duramax LB7/LLY controllers 
 
Allison transmission controllers 
 

¶ Display and clear diagnostic trouble codes 

¶ EPA test results 

¶ Generic PIDs 

¶ Enhanced PIDs 

¶ DMA PIDs 

¶ Bidirectional controls 

¶ Learned fuel trim cells 

¶ Miscellaneous calibration data 

¶ Scan modes: 
o General 
o Dynamic 
o Stream-Slow 
o Stream-Fast 

 

GM Custom 
SAE J1850 VPW 

EFILive provides user level configuration files that may be 
edited, so that EFILive can log most OBD II compliant GM 
vehicleôs enhanced parameters. 

If you know the vehicleôs enhanced parametersô PID 
numbers and SLOT details, then you can create a 
configuration to support that GM vehicle. 
 

Ford Not supported. 
 
 

DaimlerChrysler Not supported. 
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SSEETTUUPP  GGUUIIDDEE  

Connecting and starting 

Location of the OBD II connector 

The OBD II connector is located in the passenger compartment within reach of a technician seated in the 
driverôs seat. 
Access to the connector does not require any special tools for the removal of any instrument panel 
cover, connector cover or any barriers that may be obscuring the connector. 

 

 

 

 
Left hand drive Right hand drive 

Connecting your FlashScan V2 USB interface cable 

If your computer is fitted with a USB port, connect the FlashScan interface cable as shown in this 
diagram.  

If your computer is not fitted with a USB port then you cannot use that computer with a FlashScan 
interface cable. 

 

 

WARNING 

The RJ45 connector used on FlashScanôs OBDII cable is 
the same size as a standard network cable plug. Never 
connect the OBDII cable directly to your computerôs 
network socket. You will almost certainly damage your 
PCôs network connection. 

And never connect FlashScan directly to a network 
cable, you may damage the FlashScan interface. 
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Connecting your FlashScan V2 interface for black-box logging 

To record data directly to your FlashScan interface, connect it to your vehicle like this. 

 

 

 
The initial release of FlashScan V2 does not support black box logging. Black box logging 
will be made available free of charge via Internet download, when it is available for 
FlashScan V2. 
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Connecting your FlashScan V1 USB interface cable 

If your computer is fitted with a USB port, connect the FlashScan interface cable as shown in this 
diagram. 

 

If your computer is not fitted with a USB port then you cannot use that computer with a FlashScan 
interface cable. 

Connecting your FlashScan V1 interface for black-box logging 

To record data directly to your FlashScan interface, connect it to your vehicle like this. 
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Connecting your AutoTap USB interface cable 

If your computer is fitted with a USB port, connect the interface cable as shown in this diagram. 

 

If your computer is not fitted with a USB port then you should use one of the serial (9-pin RS232) 
interface cables shown below. 

 

Connecting your AutoTap serial (9-pin RS232) interface cable 

If your computer is fitted with a standard 9-pin RS232 serial COM port then connect the interface cables 
as shown in this diagram. 

 

 

 
Never connect the OBD II cable directly to your computerôs RS232 serial COM port. 
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Using a USB to RS232 Serial converter 

If, like most modern Pentium laptops, your computer is not fitted with a standard 9-pin RS232 serial 
COM port, you will require an additional USB (Universal Serial Bus) to RS232 serial converter cable. 
 

 
A USB to serial converter will not work with EFILive FlashScan. FlashScan draws itôs 
operating power from the USB connection. Apart from the protocol complexities, serial 
ports do not provide power to operate the FlashScan unit. 

Select your USB converter cable carefully. Note that some converters are better then others. EFILive 
recommends the Edgeport USB to serial converter cables. 

 

 

 
Never connect the OBD II cable directly to the USB to serial converter. 

 

 
If the OBD II interface is left connected to the OBD II connector for a significant length of 
time (i.e. overnight), the OBD II interface may drain the battery, even if it is not connected 
to a laptop or being used by EFILive. 

We recommend unplugging the OBD II interface when not in use for extended periods. 
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Starting the EFILive Scan Tool 

The Scan Tool can be used in two modes: 

1. Connected ï when a connection exists to an OBD II vehicle. 
2. Disconnected  - when no connection exists to an OBD II vehicle. 

When the Scan Tool is disconnected, functions that require a connection are disabled. 

We recommend that the first time you use the Scan Tool you should make at least one successful 
connection to the OBD II vehicle. That way the Scan Tool can gather information about the vehicle, 
including the VIN, which parameters are supported, and which onboard modules are available. The 
information will be saved and used by the Scan Tool if and when you choose to use it when not 
connected to a vehicle. 

There are three simple ways to start the Scan Tool: 

¶ Double click on the EFILive Scan Tool icon on the Windows desktop that looks like this: 
 

 
 

¶ Click on Windows Start button, then select: Programs->EFILiveV7->Scan Tool 
 

¶ Double click on any *.efi (logged data file). 
The Scan Tool will start automatically, and display the selected log file. 
 

 
You may start multiple instances of the Scan Tool. Additionally, you may even load the 
same log file into different windows. 

  

 
We recommend starting only one copy of the Scan Tool when also using the EFILive 
Tuning Tool with data being linked between them. You may have multiple instances of the 
Tuning Tool open and they will all link to the single instance of the Scan Tool. 

  

 
You cannot have multiple instances of the Scan Tool connected to a vehicle at the same 
time via the same interface cable. 
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Starting the Scan Tool for the first time 

The first time you run the Scan Tool you will see the following message. 

 

The Scan Tool needs to know at least the first 4 characters of the vehicleôs VIN so that it can load the 
appropriate set of enhanced PIDs. Because no connection has yet been made to the vehicle, you should 
supply the VIN or select the platform that best matches your vehicle. 

When you make a connection to a vehicle, that vehicleôs VIN will replace the Operating system and VIN 
that you may have selected. The Scan Tool will remember the last used Operating system and VIN and 
will use them the next time it is started. 

To properly configure the transmission PIDs, the Scan Tool also needs to know if the vehicle has an 
automatic or manual transmission, select Automatic or Manual as appropriate. 

EFILive uses the engine displacement and vehicle weight when evaluating calculated PIDs such as 
{CALC.POWER_RW} ñRear Wheel Horsepowerò. Those PIDs will only be as accurate as the information 
entered here. 
 

 
Each time you save a log file, these settings are embedded into the log file. If you change 
any of these settings, you must re-save the log file, which embeds the new values into the 
log file. 
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To connect to the vehicle 

 
File->Connect 

[ ] Connect 

 
Ctrl+F3 

Registering the interface for use with EFILive 

When EFILive connects to a vehicle the interface is checked to determine if it is registered. If the 
interface is not registered, EFILive will ask you if you want to register the interface. 

 

You may choose not to register the interface, but you cannot log or monitor data, nor use bidirectional 
controls with an unregistered interface. 
 

 
If you are using a FlashScan interface cable, registration is not required while it is 
connected to the PC. However, until you successfully register your FlashScan cable, the 
Tuning Tool (not the Scan Tool) will default to ñDemo Modeò with limited access to most 
calibrations, if the FlashScan cable is not connected. 

See page 56 for instructions on how to register your interface for use with EFILive. 
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To start monitoring data 

[ ] Start monitoring data 

 
Ctrl+M 

To start recording data 

[ ] Start recording data 

 
F3 

All logged data will be displayed in the [Data (F9)] tab page. It shows each PIDôs current, minimum, 
maximum and average values. 

Some PIDs will be displayed in the [Dashboard (F10) - A] virtual dashboard as analog or digital gauges. 

Some PIDs will be charted in the [Dashboard (F10) - B] virtual dashboard on charts. 

By default, no data is displayed in the [Dashboard (F10) - C] virtual dashboard. That is a ñscratchò area 
for you to ñtry outò different gauge and chart settings so you donôt have to disturb the default virtual 
dashboards. 

To pause logging 

[ ] Pause data 

 
Ctrl+Space 

  

 
If, while data logging, the cables are disconnected or the ignition is switched off, the 
Scan Tool will pause data logging. When the cables are reconnected or the ignition is 
switched back on, it will reinitialise the connection to the vehicle and continue data 
logging. 

  

 
Disconnecting the FlashScan cable from the PC while data logging may cause the USB 
subsystem to terminate the USB connection. The Scan Tool may not be able to recover 
when the FlashScan interface is reconnected. In that case, you will need to re-establish 
the connection and restart data logging. 

During data logging, the pause button toggles the Scan Tool from Record mode to Monitor mode each 
time it is pressed. 

During playback the pause button will pause or resume playback. 

To stop logging 

[ ] Stop data 

 
F4 
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To disconnect from vehicle 

 
File->Disconnect 

[ ] Disconnect 

 
Ctrl+F4 

  

 
If the link between EFILive and the vehicle is not disconnected properly, the interface 
cable may continue to communicate with the PCM via the class 2 data bus, even when 
the ignition is switched off. 

To exit from the Scan Tool  

 
File->Exit 

 
Alt+F4 

Exiting from the Scan Tool while data logging is active will terminate data logging. 
 

 
If, while data logging, the Scan Tool is terminated incorrectly (for example: a power 
failure) then the currently recording log file can usually be recovered, see Appendix-D. 

Exiting from the Scan Tool while bidirectional controls are active will terminate bidirectional controls and 
return the vehicleôs PCM to its default calibrations. 
 

 
If, while using bidirectional controls, the Scan Tool is terminated incorrectly (for example: 
a power failure) the bidirectional controls will not be released until the interface cable is 
disconnected from the vehicle or the vehicleôs ignition is switched off. 
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HHOOTTKKEEYYSS  QQUUIICCKK  RREEFFEERREENNCCEE  

Main Display Hotkeys 

Hotkey Description 
  

F1 Help 

F2 Keyboard only inspect 

F3 Start data logging 

F4 Hide and disable the Control Panel if it is visible, 
Otherwise, stop data logging. 

F5 Show and activate the LS1 control panel 

F6 Show and activate the Allison control panel 

F7 Show onboard information window [OBD II (F7)] tab page. 

F8 Show PID selection table [PIDs (F8)] tab page. 

F9 Show parameter table [Data (F9)] tab page. 

F10 Show virtual dashboard [Dashboard (F10)] tab page 

F11 Show maps [Maps (F11)] tab page 

F12 Show console window [Console (F12)] tab page 

  

Shift+F1 Retrieve all test results 

Shift+F2 Validate PIDs 

Shift+F3 Validate Modules 

Shift+F4 PCM info 

Shift+F5 System readiness tests results 

Shift+F6 Specifically monitored systems tests results 

Shift+F7 O2 sensors tests results 

Shift+F8 Diagnostic trouble codes 

Shift+F9 History freeze frame data 

Shift+F10 Clear emissions related trouble codes 

Shift+F11 Clear trouble codes for all modules 

Shift+F12 Not used 

  

Shift+Ctrl+F1 Display miscellaneous calibration information 

Shift+ Ctrl+F2 Display long term fuel trim cells 

Shift+ Ctrl+F3 Display auto transmission adaptive shift cells 

Shift+ Ctrl+F4 Display Allison transmission adaptive shift cells 

Shift+ Ctrl+F5  

Shift+ Ctrl+F6 Display Idle air control panel 

Shift+ Ctrl+F7 Display cylinder balance test 

Shift+ Ctrl+F8 Display CKP Learn (Crank position sensor error learning) 

Shift+ Ctrl+F9 Change VIN 

Shift+ Ctrl+F10 Oil life reset 

Shift+ Ctrl+F11  

Shift+ Ctrl+F12  
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Main Display Hotkeys (contôd) 

Hotkey Description 
  

Ctrl+A Select all data in current control 

Ctrl+C Copy selected text to clipboard 

Ctrl+D Edit vehicle/customer details 

Ctrl+E Export logged data to *.csv (Microsoft Excel format) 

Ctrl+F Resize dashboard to fit current screen 

Ctrl+G Generate error report 

Ctrl+I Display/Edit log file info and comments 

  

Ctrl+N New log file 

Ctrl+O Open existing log file 

Ctrl+P Print 

Ctrl+Alt+P Print all 

Ctrl+S Save log file 

Ctrl+T Save console text 

Ctrl+V Paste text from clipboard to current edit box 

Ctrl+X Cut selected text 

Ctrl+Y Show profile window 

Ctrl+Z Undo last change to the current edit box 

Ctrl+Ins Display Windows Notepad 

  

Alt+F4 Exit the Scan Tool 

Alt+Enter Open the Scan Tool properties editor 

Ctrl+Enter Open the Map properties editor 

Ctrl+Alt+C Enter new Controller type 

Ctrl+Alt+V Enter new VIN and other vehicle information 

  

Ctrl+Alt+Enter Edit data filter settings and select current filter 

Ctrl+Alt+F Apply/remove currently selected data filter 

  

Ctrl+Alt+Q Re-order PIDs on the [Data (F9)] tab page in custom order. 

Ctrl+Up Move current PID up one place in the [Data (F9)] tab page. 

Ctrl+Down Move current PID down one place in the [Data (F9)] tab page. 

  

Shift+Del Clear console text 

  

Ctrl+Space Pause/Resume data logging 

Ctrl+F2 Fetch chart inspector 

Ctrl+F3 Connect 

Ctrl+F4 Disconnect 

  

Ctrl+PgUp Read black-box logged data from FlashScan 

Ctrl+PgDn Configure FlashScan for black-box logging 

Ctrl+F10 Start the EFILive Tuning Tool 

Ctrl+F11 Display FlashScan V2 Control Panel 

  

Ctrl+1 Set highlighted PIDs to priority 1 

Ctrl+2 Set highlighted PIDs to priority 2 

Ctrl+3 Set highlighted PIDs to priority 3 
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Dashboard Hotkeys 

Hotkey Description 
  

A Show dash page A 

B Show dash page B 

C Show dash page C 

  

Ctrl+W Tile charts to cover entire dashboard 

  

Ctrl+Alt+N Zoom none 

Ctrl+Alt+Z Zoom 1:1 

Ctrl+Alt+I Zoom in 

Ctrl+Alt+O Zoom out 

Ctrl+Alt+S Zoom selected data 

Ctrl+Alt+A Zoom all data 

  

Shift+Ctrl+N New dash page 

Shift+Ctrl+O Open dash page 

Shift+Ctrl+S Save dash page 

Shift+Ctrl+T Save dash page with a new name 

 

Map Hotkeys 

Hotkey Description 
  

A Show map page A 

B Show map page B 

C Show map page C 

D Show map page D 

E Show map page E 

F Show map page F 

G Show map page G 

H Show map page H 

I Show map page I 

J Show map page J 

  

Shift+Ctrl+C Copy selected map cells and labels to clipboard  

Shift+Ctrl+M Open a new map 

Shift+Ctrl+R Replot current map 

  

Ctrl+, Show cellsô minimum value 

Ctrl+. Show cellsô maximum value 

Ctrl+= Show cellsô count value 

Ctrl+- Show cellsô average value 
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Record/Playback Hotkeys 

Hotkey Description 
  

Ctrl+Q Mute/Unmute audible gauge alarms 

Ctrl+R Re-plot charts 

Ctrl+M Start monitoring data 

F3 Start recording data 

F4 Stop data logging or playback 

Ctrl+L Playback recorded log file at selected speed 

Ctrl+Space Pause/Resume data logging or playback 

Home Move chart inspector to first frame 

PgUp Move chart inspector to previous note 

Ctrl+Left Move chart inspector backward multiple frames 

Left Move chart inspector backward one frame 

Right Move chart inspector forward one frame 

Ctrl+Right Move chart inspector forward multiple frames, or if playing back, playback 
at full speed 

PgDn Move chart inspector to next note 

End Move chart inspector to last frame 

Ctrl+Del Delete selected chart data. 

  

0..9 Search forward through log file for matching note number. 

Ctrl+0..9 Search backward through log file for matching note number. 
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LS1 Control Panel Hotkeys 

Hotkey Description 
F4 Deactivate and hide the control panel 

F5 Show and activate the control panel 

  

Ctrl+F6 Select Engine tab page 

Ctrl+F7 Select Transmission tab page 

Ctrl+F8 Select Spark/Fuel tab page 

  

Engine tab page hotkeys 

M Check/Uncheck MIL 

K Check/Uncheck Skip shift lamp 

C Check/Uncheck CC inhibit 

U Check/Uncheck A/C clutch 

W Check/Uncheck Fan low 

H Check/Uncheck Fan high 

I Check/Uncheck A.I.R sol 

P Check/Uncheck A.I.R pump 

F Check/Uncheck Fuel pump 

S Check/Uncheck Purge sol 

V Check/Uncheck Vent sol 

O Check/Uncheck Closed loop 

L Check/Uncheck Fuel learn 

Z Zero fuel trims 

  

Transmission tab page hotkeys 

G Check/Uncheck Gear 

1 Select 1
st
 gear 

2 Select 2
nd

 gear 

3 Select 3
rd

 gear 

4 Select 4
th
 gear 

A Toggle shift solenoid A 

B Toggle shift solenoid B 

W Check/Uncheck TCC PWM 

T Check/Uncheck TCC solenoid 

S Check/Uncheck 3-2 solenoid 

P Check/Uncheck PCS current 

R Check/Uncheck Reverse lockout 

K Check/Uncheck Skip shift 
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LS1 Control Panel Hotkeys (contôd) 

Spark/Fuel tab page hotkeys 

  

D Check/Uncheck Delta spark control 

S Check/Uncheck Absolute spark control 

F Check/Uncheck Fuel control 

  

Shared hotkeys 

Y Select [Y] for current control 

N Select [N] for current control 

U Uncheck all 

+ ¶ Increase PCS current by 10mA 

¶ Increase Spark by 0.1 degree 

¶ Increase AFR by 0.1 

- ¶ Decrease PCS current by 10mA 

¶ Decrease Spark by 0.1 degree 

¶ Decrease AFR by 0.1 

Shift+= 
(aka Shift++) 

¶ Increase PCS current by 100mA  

¶ Increase Spark by 1.0 degree 

¶ Increase AFR by 1.0 

Shift+- ¶ Decrease PCS current by 100mA  

¶ Decrease Spark by 1.0 degree 

¶ Decrease AFR by 1.0 
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Allison Control Panel Hotkeys 

Hotkey Description 
F4 Deactivate and hide the control panel 

F6 Show and activate the control panel 

  

M Check/Uncheck MIL 

T Check/Uncheck TCC engage 

  

G Check/Uncheck Gear 

5 Select 5
th
 gear 

4 Select 4
th
 gear 

3 Select 3
rd

 gear 

2 Select 2
nd

 gear 

1 Select 1
st
 gear 

  

C Check/Uncheck Clear all TAP cells 

G Check/Uncheck Clear all Garage TAP cells 

A Select all 

U Unselect all 

S Clear selected cells 

P Preset all TAP cells 

  

U Uncheck all 

M More info 
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Idle Air Control Hotkeys 

Hotkey Description 
  

F4 A/C on/off 

F5 Fan low on/off 

F6 Fan high on/off 

+ Increase idle speed 

- Decrease idle speed 

F9 Select RPM to control idle speed 

F10 Select IAC to control idle speed 

F11 Select ETC to control idle speed 

F12 Select IAC/98 to control idle speed 

Alt+M More info 

Escape Close window 

 

Cylinder Balance Test Hotkeys 

Hotkey Description 
  

F3 Start test 

F4 Abort test 

+ Increase idle speed 

- Decrease idle speed 

F10 Select IAC to control idle speed 

F11 Select ETC to control idle speed 

F12 Select IAC/98 to control idle speed 

Alt+P Print results of cylinder balance test 

Alt+M More info 

Escape Close window 

 

Crank Position Sensor Relearn Test Hotkeys 

Hotkey Description 
  

F3 Start test 

Alt+M More info 

Escape Close window 
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MMEENNUUSS  

File 

 

Connect 

Searches for a supported OBDII interface cable and connects to it. Once a connection has been 
made to the OBDII cable, EFILive will attempt to connect to the vehicle. 

Disconnect 

Disconnects EFILive from the OBDII interface cable. 
 

 
You MUST disconnect the Scan Tool software from the OBDII interface cable prior to 
performing any action in the Tuning Tool software that requires connecting to the OBDII 
interface cable. 

New 

New log file 

Clears currently loaded log file data. 
You may not change which PIDs are selected while data exists in the Scan Tool. Before 
attempting to change any PID selections, you need to select this option to clear the data. 
You may add or remove calculated PIDs without first clearing data. 

New PID selection 

Clears the selected PIDs so that no PIDs are selected. This option is only available when no 
logged data exists. Use the ñNew log fileò option to clear logged data prior to using this option. 

New dashboard 

Clears the currently loaded dashboard 

New dashpage 

Clears the currently displayed dashpage 

Open 

Open log file 

Opens and displays previously recorded log files. 

Open PID selection 

Opens and loads a new PID selection file. 

Open dashboard 

Opens and displays a new dashboard file 

Open dashpage 
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Opens and displays a new dashpage file in the currently display dashpage. 

Open map 

Opens and displays a new map file in the currently displayed map page. 

Save 

Save log file 

Saves the current data using the most recently used log file name. 

Save PID selection 

Saves the current list of selected PIDs. 

Save dashboard 

Saves the dashboard layout and associated dashpages. 

The dashboard will need saving if you: 

¶ Add or remove any gauge, status or chart. 

¶ Move or resize any gauge, status or chart. 

Save dashpage 

Saves the currently displayed dashpage. 

Save asé 

Save log file as 

Saves the current data with a new filename. 

Save PID selection as 

Saves the current list of selected PIDs with a new filename. 

Save dashboard as 

Saves the dashboard layout and associated dashpages with a new filename. 
 

 
Always save dashboards in the My Documents\EFILive\V7\VDash folder. The 
Scan Tool expects virtual dashboard files (*.vdb) to be in that folder and may not 
correctly display the dashboard if they are not. 

Save dashpage as 

Saves the currently displayed dashpage with a new filename. 
 

 
Always save dashpages in the My Documents\EFILive\V7\VDash folder. The Scan 
Tool expects virtual dashpage files (*.vdp) to be in that folder and may not correctly 
display the dashboard or dashpage if they are not. 

Recent log files 

Displays a list of the most recently used log files. 
The list can be cleared at any time by selecting File->Recent files->Clear file list. 
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Exporté 

Opens the export window that allows you to export the current data, or any subset of the current 
data. 

The exported file format is compatible with Microsoft Excel and any other application that can read 
*.csv (comma separated values) formatted files. 

Select Controller 

The target controller must be correctly identified before attempting to connect. 

This option is automatically displayed when EFILive attempts to connect. EFILive ignores the 
controller selection, if you are attempting to connect to FlashScan only (i.e. not to a vehicle). 
 

 
If you have previously elected to hide the controller selection window when connecting 
to a vehicle, EFILive will use the most recent controller selection, which may not be 
correct for the target vehicle. In that case, you are responsible for selecting this menu 
option prior to connecting to each different controller. 

Enter VIN 

You may use this option to enter various details about a vehicle that would otherwise be known to 
EFILive if a vehicle was connected. EFILive uses the information that you entered to configure PID 
data. 

Generate error report 

Usually, when the Scan Tool detects an error, the error report window will be displayed. The error 
report window provides details about why the error occurred and information that the EFILive support 
team can use to help diagnose the problem. 

Sometimes the EFILive support team may ask you to ñgenerate an error reportò, even though the 
Scan Tool has not detected any error. Use this option to take a 'snapshot' of the program and the 
conditions related to its operation that can be sent to EFILive support to aid in diagnosing trouble. 

Save console text 

Saves a copy of the console text buffer. You can choose to save the *.rtf (rich text) format which 
preserves the font and color settings or in *.txt (plain text) format which does not. 

Printé 

Prints the information that is currently displayed on the screen. If the report contains no data then the 
preview is not displayed and nothing is printed. 

Print allé 

Prints the information contained in all the checked items in Properties->Printing. 
Any item that contains no data is skipped; if all items contain no data then the preview is not 
displayed and nothing is printed. 
 

 
Both print options will first display the report on the screen for you to review. Once you 
have reviewed the report on the screen, you may choose to: 

¶ Send the report to the printer. 

¶ Save the report for printing later. 

¶ Discard the report completely. 
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Display/Print saved reportsé 

If you have previously saved any reports then use this option to view and/or print them. 

Exit 

Stops data logging and disables bidirectional controls, if either is active, then exits. 
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Edit 

 

Undo 

Undoes the most recent change that you have made to any text field. A text field is any area of the 
Scan Tool where you can edit text data. 

Select all 

Selects all text in the current text field. 

Clear all 

Clears the console display ï if the console display has focus. The console display has focus if the 
cursor, a small vertical line, is flashing in the console display. If the console display does not have 
focus you can set focus by clicking in it. 

Cut 

Copies any selected text to the clipboard and then deletes the selected text. 

Copy 

Copies any selected text to the clipboard. 

Copy with labels 

Copies the selected map cells and their labels to the clipboard. 
 

 
If you intend to paste the data into a matching Tuning Tool calibration table, it is a 
good idea to use this option to copy the labels as well. 
When you ñPaste with labelsò the data into the Tuning Tool calibration table, 
EFILive will automatically align the data so that the cells with matching labels are 
updated. 

Copy and fill 

Copies selected MAP cells to the clipboard and fills any empty cells with the average value of its 
surrounding cells. The ñsmoothnessò of the fill can be controlled with the ñsmoothing weightò setting 
in the MAP property editor. 

Copy and fill with labels 

Copies the selected map cells and their labels to the clipboard and fills any empty cells with the 
average value of its surrounding cells. 

Paste 

Copies the contents of the clipboard into the current text field. 

Default customer details 

Opens the default Vehicle/Customer details window. These details are embedded into the log file 
when it is first saved. To alter the information once it has been embedded in a log file, use the Edit-
>Log file information option. 
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Log file information 

You can add comments to the current data. These comments are embedded in the log file and can 
be viewed any time a log file is loaded. 

You can also change the gross vehicle mass (GVM). The GVM is used in calculated PIDs that 
require the vehicleôs weight. 

Open Notepad 

Opens Windows Notepad for taking notes. Unlike Log file information (above), Windows Notepad 
can be opened at any time, including while the Scan Tool is logging data. You are responsible for 
saving and organizing the files created by Windows Notepad. 

Properties 

The Properties window is where you can customize most of the Scan Tool parameters - see the 
Properties Configuration section. 
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View 

 

Customize toolbars 

Hide or show selected toolbars and/or tool-tip display 

Onboard information window 

Displays the [OBD II (F7)] tab page. 

Show PID selection 

Displays the [PIDs (F8)] tab page. 

Show parameter table 

Displays the [Data (F9)] tab page. 

Show virtual dashboard 

Displays the [Dashboard (F10)] tab page. 

Show maps 

Displays the [Maps (F11)] tab page. 

Console window 

Displays the [Console (F12)] tab page. 

Profiler window 

Displays the Profiler window. 
The Profiler window provides real time information about the status of the connection to the vehicle. 

¶ Scan mode (in title bar) 

¶ Frames per second will be displayed in: 
o Red when fps is less than 1. 
o Yellow when fps is 1 or greater but less than 5. 
o Green when fps is 5 or more. 

¶ Time remaining in the current log file will be displayed as hh:mm:ss and will be: 
o Red when less than 1 minute remains. 
o Yellow when 1 or more minutes but less than 10 minutes remain. 
o Green when 10 or more minutes remain. 
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Info 

 

Retrieve all test results 

Will retrieve various PCM information and the test results for all onboard monitored systems. A 
summary of the results will be displayed in the [OBD II (F7)] tab page on the [Summary] sub page. 

Validate PIDs 

Will query the connected vehicle to determine which PIDs are supported and which are not. 
Unsupported PIDs are marked with a cross through their icon on the [OBD II (F7)] tab page [PIDs] 
sub page. 

Validate modules 

Will query the connected vehicle to determine which modules can be detected. Detected modules 
are displayed on the [OBD II (F7)] tab page [MODs] sub page. 

PCM info 

Displays the PCMôs internal calibration part numbers. For US domestic vehicles, these numbers can 
be checked on this web site calid.gm.com/vci. 

System readiness tests results 

Displays the system readiness testsô status. 

Specifically monitored systems test results 

Displays the specifically monitored systems testsô results. 

O2 sensors tests results 

Displays the oxygen sensors testsô results. 

Diagnostic trouble codes 

Retrieves and displays diagnostic trouble codes from all modules listed in the [OBD II (F7)] tab page 
[MODs] sub page. 

History freeze frame data 

Retrieves and displays any history data associated with DTCôs. 

Clear DTCs 

This option clears all trouble codes and emissions test results from the PCM. 

 
This option will reset all the EPA System Readiness Testsô status to ñNot Readyò. 

Clear DTCs for listed modules 

This option clears trouble codes from all modules listed in the [OBD II (F7)] tab page [MODs] sub 
page. 

http://calid.gm.com/vci
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Dashboard 

 

Fit dashboard/maps to window  

If you change the Scan Tool window size you can use this option to automatically reposition and 
resize the gauges, status and charts to fill the new dashboard size. 
 

 
If you would like the gauges to ñmaintain their aspect ratioò then check this checkbox: 
Properties->Options->Maintain dashboard aspect ratio at and specify the aspect 
ratio (between 0 and 1) that you want to use. Experiment with different values until you 
find one that suits the screen size. 

The dashboardôs aspect ratio is defined as: (dashboard height) / (dashboard width). 

Mute alarms 

Mutes and un-mutes ALL audible gauge alarms. 

Lock dashboard 

Locks or unlocks the dashboard. Each time the Scan Tool is started, and each time a new 
dashboard is loaded, this option defaults to checked. Before you can move or resize any items you 
must uncheck this option. See previous section: Moving and Resizing Items. 

Snap to grid 

Causes items to snap to the specified grid size when they are moved or resized. 

Size all to grid 

Resizes all items to their nearest grid coordinates. 

Align all to grid 

Moves all items to their nearest grid coordinates. 

Recall installation defaults 

Restores the selected dashboard to its original installation default settings. The associated *.pid files 
are also restored. 

Filter settings 

Edit data filters and select current data filter. 

Add note 

Add ñNote 0ò to the current frame. 

Use the toolbar icon/drop down list to add notes other than ñNote 0ò. You can customize each noteôs 
description on the [Notes] tab page in the Property editor. 

Delete note 

Delete notes from the current frame. 
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Charting 

 

Zoom none 

Set chart magnification to normal. 

Zoom 1:1 

Set chart magnification so that one frame of chart data is represented by one pixel on the screen. 

Zoom in 

Increase chart magnification. 

Zoom out 

Decrease chart magnification. 

Zoom selected 

Increases or decreases chart magnification to display the chartsô selected area as the full width of 
the chart display. 

Zoom all 

Shows the entire log file in the chart display. 
 

 
The chart magnification level affects chart display speed, and therefore overall 
performance. Zoom in to display less data points and faster chart display speeds. 
Zoom out to display more data points but slower chart display speeds. 

Tile charts 

Arrange charts so that they completely fill the dashboard. 
This option is only available if and only if the currently displayed dashpage contains only charts. 

Keyboard only inspect 

When you move the mouse over the charts, the chart inspector (the vertical line that shows the 
current frame) follows the mouse. If you are using the arrow keys for fine control over the chart 
inspector, check this option to prevent mouse movements from accidentally changing the chart 
inspector position. 

Fetch chart inspector 

If you scroll the charts so that the chart inspector is no longer visible, and Keyboard only inspect is 
checked, then use this option to bring the chart inspector back into visibility. 
If Keyboard only inspect is not checked, then just move the mouse over the charts to ñfetchò the 
chart inspector. 
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Calibration 

 

These tools are designed for LS1/LS6 engines only. Some parameters may work on Duramax PCMs but 
are not guaranteed to be accurate. 

Miscellaneous calibration information 

Displays miscellaneous calibration information, for LS1/LS6 only such as: 

¶ Engine size 

¶ Transmission type 

¶ Differential ratio 

¶ 4WD status 

¶ Speed limiter 

¶ OBD II compliance 

¶ Location of O2 sensors 

¶ MAF/ESC component test results 

¶ Fan type 

¶ Fan on/off temperatures 

¶ PCM memory test results 

Long term fuel trim cells 

Displays the long-term learned fuel trim cells, for LS1/LS6 only. 

Auto transmission adaptive shift cells 

Displays the learned transmission adaptive shift cells, for LS1/LS6 only. 

Some vehicle calibrations are configured to alter the transmission line pressures in order to achieve 
the desired shift times. This table shows those learned values. If they are all zero then adaptive shift 
is probably turned off in the PCM 

Allison transmission adaptive shift cells 

Displays the learned transmission adaptive shift cells, for Allison transmissions only. 

The Allison transmission is configured to alter the transmission line pressures in order to achieve the 
desired shift times. This table shows those learned values. 
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Bidirectional 

 

LS1/LS6 Control panelé 

Provides bidirectional controls for various auxiliary systems on the LS1/LS6 engines. 

Allison Control panelé 

Provides bidirectional controls for the Allison transmission. 

Idle air controlé 

You can adjust parameters to observe what changes they make to the idle speed. (LS1/LS6 non-
ETC only) 

Cylinder balance testé 

Sequentially disables each injector while monitoring the associated drop in RPM. The relative 
strength of each cylinder is displayed. (LS1/LS6 non-ETC only) 

CKP learné 

Performs a crank position sensor relearn. 

A relearn is necessary anytime that the physical relationship between the crank and the crank 
position sensor is disturbed, or if the PCM is replaced. (LS1/LS6 only) 

Change VINé 

Changes the VIN stored in your PCM. 

Oil life reseté 

Changes the oil life indicator stored in your PCM. 
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FlashScan 

 

Read logged data from FlashScan 

Retrieves logged data from the FlashScan interface. 

Program selected PIDs into FlashScan 

Configure the FlashScan interface for black-box logging. 

Start EFILive Tuning Tool 

Starts the EFILive Tuning Tool, or activates the Tuning Tool window if it is already started. If the 
Tuning Tool window is minimized then this option will not show the window, you need to activate it 
manually. 

FlashScan V2 Control Panel 

Displays the FlashScan V2 Control Panel, used to calibrate the 5V A/D input voltages. 
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Window 

 

Small (800x600)  

Sets the Scan Tool window to the same size it would be maximized on an 800x600 screen. 

Medium (1024x768) 

Sets the Scan Tool window to the same size it would be maximized on a 1024x768 screen. 

Large (1152x864) 

Sets the Scan Tool window to the same size it would be maximized on a 1152x864 screen. 

Extra large (1280x1024) 

Sets the Scan Tool window to the same size it would be maximized on a 1280x1024 screen. 
 

 
The Scan Tool will not set the window size to larger than the current screen resolution. 
If an attempt is made to set the window size larger than the current screen then the 
Scan Tool will simply maximize the window. 

Fit to tuning tool 

Resizes the window to fit in the top x% of the screen. X is defined in Properties->Options->Scan 
Tool startup options->Size. 
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Help 

 

Help contents 

Displays this document. 
 

 
The Scan Tool looks for this document called <install_folder>\Doc\EFILiveV7Scan.pdf. 
It must exist, and Adobe Acrobat Reader must be installed on the computer, for the 
Help menu option to succeed. 

You can download the latest version of this document (EFILiveV7Scan.pdf) here: 
www.efilive.com/downloads 

You can download the free Adobe Acrobat Reader here: 
Get Adobe Reader 

Tutorials 

Lists all *.pdf documents in the folder: Program Files\EFILive\V7\Docs\Tutorials. 
New and updated tutorials will be published from time to time and made available here: 
http://www.efilive.com/download.aspx. 
Download them and place them in the tutorials folder and they will appear in the Tutorials menu. 

EFILive home page 

Opens the computerôs default browser and attempts to navigate to EFILiveôs home page at 
www.efilive.com. 

EFILive online forum 

Opens the computerôs default browser and attempts to navigate to EFILiveôs forum page at 
http://forum.efilive.com/. 

Register EFILive 

Opens the registration window where you can add or change registration details. 
 

 
Do not attempt to alter the license details of both the Scan Tool and Tuning Tool at the 
same time. 

About 

Displays version information about the Scan Tool, connection data, and programming credits. 

 

http://www.efilive.com/downloads
http://www.adobe.com/products/acrobat/readstep2.html
http://www.efilive.com/download.aspx
http://www.efilive.com/
http://forum.efilive.com/
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RREEGGIISSTTEERRIINNGG  YYOOUURR  IINNTTEERRFFAACCEE  CCAABBLLEE  

Entering your license details 

In the past, EFILive had been copied and illegally distributed via the Internet. To protect our investment 
in EFILive (and ultimately yours too), we require you to enter a registration key, supplied by EFILive, 
which activates the EFILive software. The registration key prevents un-authorized use of the EFILive 
software and hardware. 

EFILive can store up to five separate interface cable licenses. If you have upgraded from an AutoTap 
interface cable to a FlashScan interface cable, or if you have purchased more than one FlashScan 
interface cable, then you will have multiple EFILive registration keys. You should enter all registration 
keys into the License Manager. 

The registration details are ñcase sensitiveò, which means you must use exactly the same capitalization 
when entering the details. 

 

The order in which you enter the license details is not important. EFILive will always use the license that 
matches the connected cable. If no cable is connected, EFILive will use the license that provides the 
most functionality. For example, if you had an EFILive Standard license for your AutoTap cable and an 
EFILive Personal Scan&Tune license for your FlashScan cable, then EFILive would use the EFILive 
Personal Scan&Tune license if no cable was connected. 
 

 
EFILive will not check the license details when you enter them. If any details are incorrect, 
you will not be informed immediately. EFILive will silently ignore all invalid licenses when 
searching for a valid license. 

Serial number: is the serial number of your interface cable. The serial number must be exactly 12 digits 
long. If your interface has more or less digits, then either add or remove leading zeros (000123456789) 
to make it exactly 12 digits. 
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RoadRunner serial: is the RoadRunner serial number if you are using a RoadRunner real-time 
emulator. If you are not licensed to use a RoadRunner real-time emulator then leave this field blank.  

Type: is the license type. You must specify the correct license type that you purchased, or the license 
will be ignored. 

Issue date: is the date the license was issued by EFILive. It must match the date printed on your blue 
License Registration Card. 

Key: is the 4-part, 16 letter registration key. All characters must be uppercase letters; no digits or 
punctuation characters are allowed. Any characters other than uppercase letters will be rejected. 
 

 
If your license details have been emailed to you, highlight the license details in the email and 
press Ctrl+C. Then click the [Paste] button in the License Manager window. 

Changes that you make to the license details will not take effect until the next time you attempt to 
connect to a vehicle 
 

 
The license key information that you enter is stored in a text file called: My 
Documents\EFILive\V7\User Configuration\License.txt 
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SSCCRREEEENN  DDIISSPPLLAAYYSS  

Main window 

    

The Scan Toolôs main window consists of three distinct sections: 

¶ Menu and toolbars. (The record/playback toolbar at the bottom of the window is part of the Menu 
and Toolbars section.) 

¶ The tab pages, where most of the scan tool data is displayed. 

¶ The status bar that displays the status of the Scan Tool. 

Menu and Toolbars 

 

The main menu and toolbars can be rearranged or hidden to suit the display preference. To move the 
main menu or any of the toolbars, grab the menu or toolbarôs handle with the mouse and drag it to a new 
position. 
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Tab pages 

 

Each tab page in the main window provides different data about the vehicle. The tab pages and their 
functions are explained in the next few sections. 

¶ OBD II (F7) has sub pages: Summary, PIDs, MODs, PCM, SRT, SMS, O2, DTC and FF. 

¶ PIDs (F8) 

¶ Data (F9) 

¶ Dashboard (F10) 

¶ Maps (F11) 

¶ Console (F12) 

Viewing multiple tab pages simultaneously 

You may drag any tab page (except the [OBDII (F7)] tab page) off the main window. The tab page 
will float in its own window. To replace the tab page into the main window, either close the floating 
window or drag its title bar to the blank tab page area (next to the existing tabs) in the main window. 

If you leave a tab page floating when you close the Scan Tool, it will be repositioned, floating in the 
same place and with the same size when you restart the Scan Tool. 
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Status Bar 

 

The status bar provides feedback about the state of the Scan Tool and its connection to the vehicle. 

It has three sections: 

1. A connection indicator: 
This section will display the COM port connection settings (such as Com1: 115200,8,N,1) when 
a successful connection has been made to the vehicle, otherwise it displays: Not connected. 
 
If a USB virtual com port (i.e. AutoTap ATU) cable is detected then the Scan Tool will display the 
virtual COM port number followed by the term ñUSBò. 
 
If a native USB (i.e. FlashScan) is detected then the Scan Tool will display the USB device name 
followed by USB. For FlashScan cables you should see the text: EFILive FlashScan FSP : 
USB. 
 
USB connections operate thousands of times faster than RS232 serial ports. Their speeds are 
measured in millions of bits per second (Mbps) instead of thousands or bits per second (Kbps) 

2. The current VIN, transmission and operating system details: 
When the Scan Tool first starts (before any connection to a vehicle has been made) it sets the 
current VIN and operating system to the VIN and operating system that was most recently used. 
When a connection is made to a vehicle, the current VIN and operating system is updated to the 
VIN and operating system detected in the vehicle. 
 
When the current VIN is updated, the Scan Tool searches for and loads the matching 
vehicle/customer details. 
 

 
EFILive does not automatically detect the transmission type. It is up to you to tell 
EFILive. You can set this transmission type using the Edit->Default customer 
details menu option. 

3. Tips and explanations: 
When the mouse is positioned over many of the onscreen items, a brief description of that itemôs 
function is displayed in this area. 

The color of the status bar indicates the state of the link between the Scan Tool and the vehicle. 
 

Grey The Scan Tool is not connected to the vehicle. 
The Scan Tool may be connected to the FlashScan interface cable. 

 

Blue The Scan Tool is connected to the vehicle but not currently sending or receiving data. 

 

Yellow The Scan Tool is sending or receiving data but not recording. 

 

Red The Scan Tool is sending or receiving data and recording the received data. 



EFILive V7 Scan Tool for GM Vehicles 

support@efilive.com - 61 - www.efilive.com 

[OBD II (F7)]  
On Board Diagnostics 

Summary 

 

The summary sub page displays the following details: 

¶ Supported parameters available: 
This shows how many PIDs have been validated as supported for the connected vehicle. If no 
vehicle is connected, then the Scan Tool uses the current VIN to look up the validated set of 
PIDs for that VIN, and displays that value instead. If the Scan Tool has not previously been 
connected to a vehicle with a similar VIN, then the Scan Tool will most likely display only a 
handful of PIDs (mostly calculated PIDs) as supported. 
To see an accurate list of supported PIDs, make sure you are connected to a vehicle. 

¶ Validated modules available: 
This shows how many modules have been detected for the connected vehicle. If no vehicle is 
connected, then the Scan Tool uses the current VIN to look up the detected set of modules for 
that VIN, and displays that value instead. If the Scan Tool has not previously been connected to 
a vehicle with a similar VIN, then it will not display any modules. 

¶ System readiness test (EPA) will show: 
o Not checked yet if the Scan Tool has not yet queried the PCM for the testsô status. 
o Complete if ALL supported tests are ready. 
o Incomplete if ANY supported test is not ready. 

¶ Specifically monitored tests will show: 
o Not checked yet if the Scan Tool has not yet queried the PCM for the testsô results. 
o Passed if ALL SMS tests passed. 
o Failed if ANY SMS test failed. 

¶ O2 sensor tests will show: 
o Not checked yet if the Scan Tool has not yet queried the PCM for the testsô results. 
o Passed if ALL O2 tests passed. 
o Failed if ANY O2 test failed. 

 
Starting in 2004, some GM vehicles no longer report the O2 Sensor test 
results under ñO2 sensor test resultsò. Instead, they are reported under the 
ñSpecifically Monitored Systemsò (SMS) test results. 

¶ Diagnostic trouble codes will show: 
o Not checked yet if the Scan Tool has not yet queried the PCM for DTCs. 
o Not detected if DTCs were not detected. 
o Detected if ANY DTCs were detected. 
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¶ History freeze frames will show: 
o Not checked yet if the Scan Tool has not yet queried the PCM for freeze frame data. 
o Not detected if freeze frame data was not detected. 
o Detected if ANY freeze frame data was detected. 

¶ Scan mode Stream-Slow  will show: 
o Not checked yet if the Scan Tool has not yet queried the PCM for scan mode support. 
o Supported if Stream-Slow scan mode is supported. 
o Not supported if Stream-Slow scan mode is not supported. 

¶ Scan mode Stream-Fast  will show: 
o Not checked yet if the Scan Tool has not yet queried the PCM for scan mode support. 
o Supported if Stream-Fast scan mode is supported. 
o Not supported if Stream-Fast scan mode is not supported. 

¶ Maximum dynamic packets will show: 
o Not checked yet if the Scan Tool has not yet queried the PCM for dynamic packet 

support. 
o The maximum number of dynamic packets that the PCM supports. 
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 MODs - Modules 

 

Most modern vehicles have multiple, onboard computer systems that control various safety, performance 
and luxury features. Each module is assigned a unique ID according to the SAE J2178-1 specification. 

¶ $00-$1F Powertrain controllers  
o $00-$0F Integration/Manufacturer Expansion 
o $10-$17 Engine controllers 
o $18-$1F Transmission controllers 

¶ $20-$3F Chassis controllers 
o $20-$27 Integration/Manufacturer Expansion 
o $28-$2F Brake controllers 
o $30-$37 Steering controllers 
o $38-$3F Suspension controllers 

¶ $40-$C7 Body controllers 
o $40-$57 Integration/Manufacturer Expansion 
o $48-$5F Restraints 
o $60-$6F Driver information/Displays 
o $70-$7F Lighting 
o $80-$8F Entertainment 
o $90-$97 Personal communications 
o $98-$9F Climate control (HVAC) 
o $A0-$BF Convenience (Doors, Seats, Windows, etc.) 
o $C0-$C7 Security 

¶ $C8-$CB Electric Vehicle Energy Transfer System (EV-ETS) 
o $C8 Utility connection services 
o $C9 AC to AC conversion 
o $CA AC to DC conversion 
o $CB Energy storage management 

¶ $CC-$CF Future expansion 

¶ $D0-$EF Manufacturer specific 

¶ $F0-$FD Off-Board Testers/Diagnostic scan tools 

¶ $FE-$FE All nodes 

¶ $FF-$FF Null node 
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Validated modules are stored in a file called <data_folder>\PIDs\<VIN>.vml, where <VIN> is the first 11 
digits of the vehicleôs VIN. When the Scan Tool first connects to a vehicle it checks for a matching 
<VIN>.vml file. If it finds one it skips the automatic module detection and uses the list of modules in the 
<VIN>.vml file. If it does not find one then it automatically detects the modules and saves the result in the 
appropriate <VIN>.vml file for future reference. 
 

 
The Scan Tool can be configured to use a passive module detection method that can 
sometimes not detect certain modules. 

If you believe the Scan Tool has not detected all modules present in your vehicle, you may 
change the detection mode to active by checking the following property: 
Properties->Options->Use active module detection, then re-validating the modules. 
Active module detection may reset some modulesô current settings, such as the radioôs 
volume and HVAC vent settings.  

Alternatively, if you know that the vehicle has a module that the Scan Tool did not detect 
and you know the module ID, you can manually add that moduleôs ID to the <VIN>.vml file 
in the <data_folder>\PIDs folder. 
 
If you later select to validate modules, you will be warned that any changes you may have 
made to the <VIN>.vml file will be lost. 

 

Each time the Scan Tool checks for trouble codes; all listed modules will be queried and all modulesô 
detected trouble codes will be displayed. 

The Scan Tool provides two methods for clearing trouble codes: 

 
Info->Clear emissions related trouble codes 

[ ] Clear emissions related trouble codes. 

 
Shift+F10 

 

 
The ñClear emissions related trouble codesò option will clear ALL trouble codes from the 
engine controller ï not just emissions related trouble codes. However, this option does not 
clear trouble codes from any other module. 

 

 
Info->Clear trouble codes for all modules 

[ ] Clear trouble codes for all modules. 

 
Shift+F11 
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PCM ï Powertrain Control Module 

 

When a connection is made to a vehicle, the following details are retrieved from the PCM: 

¶ VIN 

¶ PCM HDW Number 

¶ Calibration ID 

¶ Serial Number 

¶ Operating System Software 

¶ Engine Calibration 

¶ Engine Diagnostic Calibration 

¶ Transmission Calibration 

¶ Transmission Diagnostic Calibration 

¶ Fuel System Calibration 

¶ System Calibration 

¶ Speedometer Calibration 

¶ Operating System BCC 

For US domestic vehicles, these part numbers can be checked on this web site: 
http://tis2web.service.gm.com/tis2web 
 

 
For early model F and Y bodies that do not report an Operating System Software number, 
the Scan Tool will substitute a ñgenericò value as follows: 

19980100: 1998 F body 
19970200: 1997 Y body 
19980200: 1998 Y body 

These numbers have no significance except that they are used internally by the Scan Tool 
for configuration purposes. 

http://tis2web.service.gm.com/tis2web
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SRT ï System Readiness Tests (EPA) 

 

OBD II compliant vehicles can have up to eleven systems that are monitored by the onboard electronics. 

¶ Catalyst 

¶ Heated Catalyst 

¶ Evaporative Purge System 

¶ Secondary Air System 

¶ A/C System Refrigerant 

¶ Oxygen Sensor 

¶ Oxygen Sensor Heater 

¶ EGR System 

¶ Misfire Monitoring 

¶ Fuel System Monitoring 

¶ Comprehensive Component Monitoring 

For each monitored system, the table shows whether the diagnostic testing of that system is supported, 
and if so, whether the test results are "Ready" or "Not Ready". If some supported tests have NOT been 
completed then some test results may be invalid. 

The status does not indicate success or failure of each test, merely whether each testsô results are 
"Ready" or "Not Ready". 

If a system is detected to be faulty, the detected faults will be exposed as Diagnostic Trouble Codes 
(DTCs) and in the O2 testsô results and the SMS testsô results. 

The status of all supported tests will be set to "Not Ready" if the DTCs are cleared and/or if power is 
removed from the PCM. 

Once reset, each supported test may take one or more drive cycles to return to the "Ready" state. See 
Appendix-F for instructions on how to perform the GM drive cycle. 

Depending on the year of manufacture of the vehicle, emissions testing stations may allow zero, one or 
two of the supported tests to be in the "Not Ready" state. 
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SMS ï Specifically Monitored Systems 

 

SMS test results from a year 2000 LS1/LS6 PCM. 

 

SMS test results for model year 2004 LS1/LS6 PCM 
(note the O2 sensor test results: Test ID $05) 

The vehicle manufacturer is responsible for assigning Test ID's (TID) and Component ID's (CID) for tests 
of different systems and components. The service technician will need to obtain the TID and CID 
descriptions from the vehicle manufacturer. 

Test results are requested by test ID. Only one test limit (maximum limit or minimum limit) is included in 
each result. If a particular test has both a maximum and a minimum limit then two test results are 
reported for the component.  



EFILive V7 Scan Tool for GM Vehicles 

support@efilive.com - 68 - www.efilive.com 

The latest test results are retained, even over multiple ignition-off sequences until replaced by more 
recent test results. 

Examples of specifically monitored systems are: 

¶ Catalyst monitoring. 

¶ Evaporative system monitoring. 

Some manufacturers use these test results in place of the O2 testsô results. 

This report was previously called "Non-Continuously Monitored Systems' Test Results". 

 

 Test IDôs and Component IDôs can be checked at GMôs web site here: 
http://si2000.ecomm.gm.com/gmspo/mode6/index.html 
Test IDôs and Component IDôs are listed under ñMode 6  Dataò. 

http://si2000.ecomm.gm.com/gmspo/mode6/index.html
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O2 ï O2 Sensor Test Results 

 
The O2 sensor test results for LS1/LS6 model year 2004 (and later) may be displayed via 
the SMS test results instead. (See previous section for SMS test results explanation). 

 

The O2 sensors are constantly monitored by the PCM to ensure correct engine operation. 

The test results indicate whether or not the O2 sensors are performing within specification. 

The latest test results are retained, even over multiple ignition-off sequences, until replaced by more 
recent test results. 

Sample O2 sensor output showing test IDs $01 through $09. 

 

¶ $01 Rich to lean sensor threshold voltage 

¶ $02 Lean to rich sensor threshold voltage 

¶ $03 Low sensor voltage for switch time calculation 

¶ $04 High sensor voltage for switch time calculation 

¶ $05 Rich to lean sensor switch time 

¶ $06 Lean to rich sensor switch time 

¶ $07 Minimum sensor voltage for test cycle 

¶ $08 Maximum sensor voltage for test cycle 

¶ $09 Time between sensor transitions 
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DTC ï Diagnostic Trouble Codes 

 

If a malfunction is detected in any of the onboard vehicle electronic systems, a Diagnostic Trouble Code 
will usually be set. 

Some DTCs are considered pending (PTC) and are primarily used to assist the service technician after a 
vehicle repair, and after clearing diagnostic information, by reporting the test results after a single driving 
cycle. If the test failed during the driving cycle, the PTC associated with that test will be reported. Test 
results reported by this mode do not necessarily indicate a faulty component/system. If test results 
indicate a failure after additional driving, then the MIL will be illuminated and a DTC will be set. PTCs will 
display "P" in the status column. 

Some DTCs also save a freeze frame (snapshot) of the current operating conditions when the 
malfunction was detected. DTC's that have freeze frame data available will display "H" in the status 
column. 

The [Legend] button will display the Status legend window. 

 
Emissions related DTCs that are reported as EPA and/or EPA Pending may also be 
reported as MIL or Pending. This is because the Scan Tool first retrieves and displays all 
emissions related DTCs as legislated by CARB. Then the Scan Tool retrieves and displays 
all manufacturer enhanced DTCs including emissions related DTCs. This method of 
display offers the user the opportunity to discern which DTCs are CARB/emissions related 
and which are not. 

By default, the Scan Tool only retrieves trouble codes with a status of M, P, H or C. You can change 
which trouble codes the Scan Tool reports here: Properties->Advanced->Diagnostic trouble codes-
>Display DTCôs. 

 














































































































































































































































